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2BINBIT LICENSE AGREEMENT 

 

SOFTWARE PRODUCT: FULLSHOT FOR WINDOWS 

 
IMPORTANT - READ CAREFULLY: THIS INBIT END-USER LICENSE AGREEMENT IS A LEGAL AGREEMENT 

BETWEEN YOU AND INBIT INC FOR THE INBIT SOFTWARE PRODUCT IDENTIFIED ABOVE, WHICH INCLUDES 

COMPUTER SOFTWARE AND RELATED DOCUMENTATION. BY INSTALLING, COPYING OR OTHERWISE USING THE 
SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU 

DO NOT AGREE TO THESE TERMS, YOU SHOULD RETURN THE UNUSED PRODUCT, INCLUDING THE PACKAGING 

AND ALL WRITTEN MATERIALS, TO THE PLACE OF PURCHASE PROMPTLY FOR A FULL REFUND. 
 

1.  GRANT OF LICENSE.  This Agreement grants to you the right to use one copy of the SOFTWARE PRODUCT 

on a single computer. You may load one copy into permanent memory of one computer and may use that copy only on 

that same computer. You may not install the software on a network server unless you purchase an appropriate license. 

 

2.  COPYRIGHT.  The SOFTWARE PRODUCT and accompanying written materials are owned by Inbit Inc and is 

protected by copyright laws of the United States, by laws of other nations, and by international copyright treaties. The 

SOFTWARE PRODUCT is licensed, not sold. 

 

3.  RESTRICTIONS ON USE AND TRANSFER.  You may not copy the SOFTWARE PRODUCT, except that (1) 

you may make one copy of the SOFTWARE PRODUCT solely for backup or archival purposes, and (2) you may 

transfer the SOFTWARE PRODUCT to a single hard disk provided you keep the original solely for backup or archival 

purposes. You may permanently transfer the SOFTWARE PRODUCT (including the most recent update and all prior 

versions) if you retain no copies and the transferee agrees to be bound by the terms of this Agreement. Such a transfer 

terminates your license. You may not rent or lease the SOFTWARE PRODUCT or otherwise transfer or assign the 

right to use the SOFTWARE PRODUCT, except as stated in this paragraph. 

 

4.  LIMITED WARRANTY.  Inbit warrants that the SOFTWARE PRODUCT will perform substantially in 

accordance with the accompanying written materials for a period of 60 days from the date of your receipt of the 

SOFTWARE PRODUCT. Any implied warranties on the SOFTWARE PRODUCT are limited to 60 days. 

 

5.  NO OTHER WARRANTIES.  INBIT DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, 

INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 

PURPOSE, WITH RESPECT TO THE SOFTWARE PRODUCT AND THE ACCOMPANYING WRITTEN MATERIALS. 

 

6.  CUSTOMER REMEDIES.  INBIT'S ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY SHALL BE, AT INBIT'S 

CHOICE, EITHER (A) RETURN OF THE PRICE PAID OR (B) REPLACEMENT OF THE SOFTWARE PRODUCT THAT DOES 

NOT MEET INBIT'S LIMITED WARRANTY AND WHICH IS RETURNED TO INBIT WITH A COPY OF YOUR RECEIPT. 

Any replacement SOFTWARE PRODUCT will be warranted for the remainder of the original warranty period or 60 

days, whichever is longer. These remedies are not available outside the United States of America. 

 

7.  NO LIABILITY FOR CONSEQUENTIAL DAMAGES.  IN NO EVENT WILL INBIT BE LIABLE TO YOU FOR 

DAMAGES, INCLUDING ANY LOSS OF PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL 

DAMAGES ARISING OUT OF YOUR USE OR INABILITY TO USE THE SOFTWARE PRODUCT. 

 

8.  U.S. GOVERNMENT RESTRICTED RIGHTS.  The SOFTWARE PRODUCT and documentation are provided 

with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions set forth in 

subparagraph (c)(1) of The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or 

subparagraphs (c)(1)(ii) and (2) of Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as 

applicable. Manufacturer is Inbit Inc. 

 

If you acquired this SOFTWARE PRODUCT in the United States, this Agreement is governed by the laws of the State 

of California. If you have any questions concerning this Agreement or wish to contact Inbit for any reason, please send 

email to support@inbit.com. 
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3BChapter 1. Introduction 

1.1 Welcome 

Welcome to FullShot! 

 

FullShot is the complete image capture, annotation and screen printing program designed for users who 

need to work with images from any application running on Windows platforms. 

 

1.2 System Requirements 

FullShot is a Windows application. It requires one of the following Windows operating systems on your 

laptops, desktops, tablets, workstations and servers: 

 

Windows XP 

Windows Vista 

Windows 7 

Windows 8.x 

Windows Server 2008/2008R2/2012/2012R2 

 

If you don't have any of the above Windows OS installed, you need to upgrade your system software before 

installing FullShot. 

 

1.3 What FullShot Can Do for You 

Capturing images 

 

 Capture images in more than 100 capture type combinations: screen capture, window capture, object 

capture, region capture, title & menu capture, freehand capture, mouse pointer capture, auto-scroll 

document capture, interactive scroll capture and session capture. 

 Capture images by using on-screen Snapshot Buttons or Hotkeys. 

 Capture images in standard resolution like 640x480, 800x600, 1024x768, 1152x864, 1280x1024, 

1366x768, 1600x1200 and even higher resolution on any Windows compatible laptops, desktops, 

tablets, workstations and servers. 

 Capture a complete screen or separate objects on the screen such as ribbon toolbars, dialog boxes, 

menus, list controls, tree controls, command buttons, radio buttons, check boxes, toolbars, and mouse 

pointers. 

 Capture any rectangular or freely drawn region of a screen you define using a mouse. 

 Capture images in continuous sessions. 

 

Adding special effects to images during capture or after capture 

 

 Add drop-shadow effects to an image in any angle, distance and size. 

 Add stroke effects to an image. 

 Add tear effects to an image. 

 Add glare effects to an image. 

 

Annotating images 

 

 Draw lines. 

 Draw rectangles and rounded rectangles. 
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 Draw circles and ellipses. 

 Write text into images. 

 Draw 18 styles of callout. 

 Mark images with labeling tools. 

 

Printing images 

 

 Print images on any printer that Windows supports automatically or manually. 

 Print images with text annotations in multiple formats. 

 Print images with a header and a footer. 

 Print images in any size. 

 Print images in multiple alignments and orientations. 

 

Viewing and Converting Images 

 

FullShot is a perfect image viewer for the following popular image formats: FSD, BMP, CUR, DIB, EPS, 

GIF, ICO, JPE, JPG, JPEG, PCD, PCT, PCX, PNG, PSD, RAS, RLE, TGA, TIF, WMF, and WPG.  

 

FullShot can convert images among supported image formats. FullShot can save images in PDF format. 

 

Editing images 

 

 Resize images. 

 Flip or rotate images. 

 Translate color images to grayscale. 

 Reduce image colors to produce smaller files. 

 Crop images to a smaller size. 

 Blur part of an image. 

 Highlight part of an image. 

 Merge two or more images into one. 

 Change image resolution. 

 

1.4 FullShot Editions 

FullShot is released in two editions: Standard Edition and Professional Edition. Below is the features chart 

for comparison. 
 

 Standard 

Edition 

Professional 

Edition 

Multiple Monitor Support   

Supported Formats   
FSD (FullShot Document)  
PDF   

BMP   
CUR   
DIB   
EPS   
GIF   
ICO   
JPG, JPE, JPEG   
PCD   
PCT   
PCX   
PNG   
PSD   



 7 

RAS   
RLE   
TGA   
TIF   
WMF   
WPG   
Pre-Save File Size Comparison   

Image Annotations   

Drawing   
Text   
Callout   
Labeling   

83BCapture Methods   

Screen Capture   
Window Capture   
Object Capture   
Region Capture (Rectangle, Ellipse)   
Title & Menu Capture   
Freehand Capture   
Mouse Pointer Capture   
Auto-Scroll Document Capture   
Interactive Scroll Capture   
Timer Controlled Session Capture   
Image Resolution Settings   

My Work Capture Management   

Today   
Yesterday   
History   

Special Effects   

Drop Shadow Effect   
Stroke Effect   
4-Way Tear Effect   
Glare Effect   

Tools   

On Screen Capture Ruler  
Resize   
Flip   
Rotate   
Crop   
Blur   
Highlight   
Eraser   
Drag-and-Drop Image Merge   
Print Image   

Image Utilities   

Legacy Tools  
Image Explorer   
Batch Conversion   

 

1.5 Installing FullShot 

1. Start Windows. 

 

2. Insert the FullShot CD into your DVD/CD drive. 
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3. If the Setup program doesn't get loaded automatically, use Windows Explorer to find D:\setup.exe and 

then double click this filename to launch the setup program. 

 If your DVD/CD is not on D: drive, use the proper drive letter. 

If you downloaded FullShot from one of the Inbit download sites, double click the installer filename to 

run the setup. 

 

4. Follow the on-screen instructions to install FullShot. 

 

1.6 Starting FullShot 

The FullShot icon should already be on your desktop when the installation is completed. Double click the 

icon to start FullShot. 

 

 
 

If FullShot Snapshot Buttons can’t be displayed on certain applications, those applications may be 

privileged. You can launch FullShot with administrator privileges: 

 

1. When you launch FullShot, right click its desktop icon; 

2. Choose Run as administrator command, which gives you higher privileges to display Snapshot Buttons 

on any applications. 

 

 
 

1.7 Uninstalling FullShot 

1. Launch the Windows Control Panel. 

2. Choose Uninstall a program. 

3. Choose FullShot 10 (Remove Only) to remove it. 

 

1.8 Technical Support 

Contact HUsupport@inbit.comUH if you have any questions. 

mailto:support@inbit.com
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4BChapter 2. FullShot Basics 

2.1 FullShot Window 

The main FullShot window is a workspace where you can view and work on a captured or imported image.  

 

 
 

2.2 Snapshot Buttons 

The easiest way to capture images is to use Snapshot Buttons. Clicking one of the buttons carries out the 

corresponding type of capture. 

 

 
 

 = Screen Capture 

 = Window Capture 

 = Object Capture 

 = Region Capture 

 =  Freehand Capture 

 

Available in the Professional Edition: 

 

 = Document Auto-Scroll Capture 

 = Interactive Scroll Capture 
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The Snapshot Buttons are displayed on the title bar of the top most application window. You can select 

what buttons to display in the Snapshot Buttons settings. If FullShot Snapshot Buttons can’t be displayed 

on certain applications, those applications may be privileged. You can launch FullShot with administrator 

privileges. See Chapter 1.6 for details. 

 

2.3 On-Screen Capture Ruler 

FullShot can display an on-screen capture ruler that can help you see how large a window capture will be 

before you launch a capture against a window. If your documentation work has a limitation on an image 

size, knowing how large your target is can be a big help. Otherwise, you would have to perform several 

trial shots in order to find out which one may fit the space available. 

 

To turn on the on-screen Capture Ruler, choose the Capture Ruler command from the View menu. 

 

 
 

Using the same command again will turn off the capture ruler. 

 

The on-screen ruler is a self-managed intelligent tool. When you drag a window frame to change the 

window size, it follows your drag and reports the new size on the ruler. It will auto hide itself if you don’t 

touch your target window for a while. 

 

The ruler can display three types of measurements: pixel, inch and centimeter. By default, it displays a 

window size in pixel mode. Right click the ruler to change the measurement to inch mode; right click again 

to change it to centimeter mode. 

 

The left image below shows the ruler in the pixel mode; the right image shows in the inch mode. 

 

   
 

2.4 Ribbon Toolbars 
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There are two ribbon bars. 

 

 
 

To know the name of a particular command button, hover the mouse pointer over it. FullShot will display 

the name shortly. 

 

Save: Use this command to save the active image to a file. 

 

Print: Use this command to print the active image. 

 

Clear: Use this command to clear the active image. 

 

Copy: Use this command to copy the active image to the Clipboard. 

 

Copy Object: Use this command to copy the selected annotation objects to the Clipboard. 

 

Paste: Use this command to paste the image from the Clipboard to the active image. 

 

Paste as New: Use this command to paste the image from the Clipboard to the FullShot window. 

 

Normal Pixel Size: Use this command to view the active image in its original pixel size. 

 

Fit to Window: Use this command to view the active image by using the entire FullShot window space. 

 

Full Screen View: Use this command to view the active image in the full screen mode. 

 

Capture to My Work: Turn on/off Capture to My Work mode. 

 

Capture to Printer: Turn on/off Capture to Printer mode. 

 

Capture to Clipboard: Turn on/off Capture to Clipboard mode. 

 

Capture to File: Turn on/off Capture to File mode. 

 

 
 

Highlight: Use this command to highlight a selected area on the active image. 

 

Crop: Use this command to trim unwanted edges on the active image. 

 

Blur: Use this command to blur a select area on the active image. 

 

Eraser: Use this command to erase a selected area on the active image. 

 

Color Checker: Use this command to check a pixel’s RGB value on the active image. 
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Normal Pixel Size: Use this command to view the active image in its original pixel size. 

 

Fit to Window: Use this command to view the active image by using the entire FullShot window space. 

 

Full Screen View: Use this command to view the active image in the full screen mode. 

 

Zoom In: Use this command to view the active image in a larger size. 

 

Zoom Out: Use this command to view the active image in a smaller size. 

 

Undo: Use this command to undo an image editing and annotation action. 

 

Redo: Use this command to revert the previous undo. 

 

Drawing tools, Callout tools and Labeling tools will be described in Chapter 9. 

 

2.5 My Work 

Your captured images are automatically saved in My Work. The newest is displayed on top. Images are 

grouped in three sections: Today, Yesterday or History. You can enable the Auto-Hide to make it hide 

itself when you work on something else. You can also close it by clicking its close button at the upper-right 

corner. 

 

 

2.6 FullShot Explorer 

The FullShot Explorer lets you open, save and delete images in an easy way. It also allows you to open 

annotation files. 
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FullShot uses the color icon  to represent an image file in one of the supported formats.  

 

To open an image file, navigate and find the file and then single click on it.  

To save an image from the FullShot window to your hard drive, drag and drop the image to the destination 

folder. 

To delete an image file, select the file and then press Del key on your keyboard. 

To rename a file, select the file and click the filename again. The FullShot Explorer will turn on the 

filename editor for you to change the filename. 

 

You can close FullShot Explorer by clicking the close button on the upper right corner. If you need to turn 

it on, choose the FullShot Explorer command from the View menu. 

 

2.7 Annotation Object Layers 

Annotation Object Layers list, or Layers for short, is initially empty. You will see it lists an image as the 

first object after you perform a screen capture or open an image file. As you add annotation objects to the 

active image, it adds your objects to the list. Each object is a layer on the image. You can change the order 

of layers in order to set positions for objects. 

 

In the sample below, there is one image object, one rectangular callout object and two vector drawing 

objects. The image object is at the bottom and is locked, which means that you can’t move the image 

object. To change object layer orders, drag an object and move the mouse pointer up and down the list. For 

more information read Chapter 9.5. 

  

 
 

2.8 Capture Effects Settings Bar 

By default, the Capture Effects Setting Bar is not displayed as part of the FullShot interface. To turn it 

on, choose the Image Effect Settings command from the View menu. It provides you a convenient way to 

change capture effect settings easily to suit your changing needs for documentation and presentation work.  
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To learn how to use the Capture Effects Settings, see Chapter 3.7 for details. 

 

2.9 Docking Interface Components 

My Work, FullShot Explorer, Layers and Effects Settings are dockable interface components that can be 

docked on any side of the FullShot main window frames. Changing docking side is a process of dragging 

the title bar, moving and releasing mouse button when you are on the docking direction control.  

 

 
 

2.10 FullShot Status Icon 
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When FullShot is loaded, the FullShot status icon is displayed in your system tray. Right click on the 

FullShot camera icon to open a popup menu. 

 

 
 

Open FullShot: Brings FullShot window to top. 

 

Enable Capture Effects: Turn on your previously selected capture effects. 

 

Disable Capture Effects: Turn off currently enabled capture effects. 

 

Exit: Quits FullShot. 

 

2.11 Capturing Images 

1. Start Windows. 

2. Start FullShot. 

3. Minimize FullShot if you wish. 

4. Start the program from which you want to capture screen images. 

5. Click one of the FullShot on-screen Snapshot Buttons. 

 If you prefer to use Hotkeys, the default Hotkeys are: 

  

Full Screen Capture CTRL+1 

Window Capture CTRL+2 

Region Capture CTRL+3 

Title & Menu Capture CTRL+4 

Freehand Capture CTRL+5 

Object Capture CTRL+6 

 

The Professional Edition has four more capture modes: 

 

Mouse Pointer Capture CTRL+7 

Document Auto-Scroll Capture CTRL+0 

Interactive Scroll Capture CTRL+F11 

Session Capture CTRL+F12 

 

A captured image is displayed in the FullShot window and is saved to My Work. 

 

If FullShot Snapshot Buttons can’t be displayed on certain applications, those applications may be 

privileged. You can launch FullShot with administrator privileges. See Chapter 1.6 for details. 

 



 16 

5BChapter 3. General Settings 

 

FullShot comes with a set of default settings. It works just fine without your changing any of its settings. 

You do have many options, however, if you want to use FullShot differently. In this chapter we present you 

with general settings which affect overall FullShot behavior. In the next chapter, we’ll discuss capture-

related settings. 

 

3.1 FullShot Run Settings 

The FullShot Run command opens up the FullShot Run Settings dialog box. 

 

   
 

You can load FullShot with Windows automatically. You can load FullShot directly in the form of a 

minimized icon on the taskbar or maximized taking the entire screen. 

 

If you choose to run FullShot in the background mode, FullShot will be hidden and it doesn't even appear 

on the taskbar. When you need to switch between the Background mode and the Foreground mode, press 

the hotkey combination Ctrl+Shift+Alt+B and Ctrl+Shift+Alt+F. 

 

By default, the FullShot Setup program has installed the FullShot icon on your desktop. You can let 

FullShot remove the icon in this dialog box. 

 

3.2 Image Window Settings 

The Image Window Settings dialog box allows you to set FullShot image window background and canvas 

background colors. 
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3.3 My Work 

You can change My Work settings by using the My Work command from the General menu. 

 

   
 

3.4 Capture Settings 

FullShot sends a captured image to the FullShot Window and My Work by default. You can also let 

FullShot send a captured image to Printer, Clipboard and File.  

 

 
 

You can also use Capture… command from the General menu to set more settings. 



 18 

   
 

If you use FullShot as a direct screen printing program, select the Printer option only, and then set print 

settings (see Chapter 6 for details). If you plan to capture and save many images during a session, you can 

make the process quick and easy by selecting the File as a destination (see Chapter 5 for details). For those 

of you who prefer to use the Clipboard to transfer captured images, select the Clipboard option. 

 

Capture settings in this page affect all of the capture types. 

 

Hide Mouse Pointer: Select if you don’t want the captured image to include the mouse pointer; leave 

unselected if you do want the image to include the mouse pointer. 

 

Open FullShot After Capture: Select if you want the FullShot window to appear above other application 

windows after you capture an image; leave unselected if you don’t want the FullShot window to appear on 

top after image captures. 

 

Resolution: You can preset a resolution so that all captured images are processed in that resolution. There 

are six preset resolutions: 72dpi, 96dpi, 120dpi, 150dpi, 300dpi and 600dpi. You can also specify a 

resolution. After an image is captured, you can change the image resolution to any value by using Change 

Resolution command from the Tools More menu. Resolution option is only available in the Professional 

Edition. 

 

 
 

3.5 Hotkey Settings 

A hotkey or hotkey combination is a way to capture images. Every capture type has its own hotkey or 

hotkey combination. A hotkey combination can be any key (except F1, which is used for Help by many 
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Windows Applications) and one or more of these system keys: CTRL, SHIFT, ESC and ALT. The default 

hotkey settings are: 

 

CTRL + 1 Screen Capture 

CTRL + 2 Window Capture 

CTRL + 3 Region Capture 

CTRL + 4 Title & Menu Capture 

CTRL + 5 Freehand Capture 

CTRL + 6 Object Capture 

 

The Professional Edition has four more capture modes: 

 

CTRL + 7 Mouse Pointer Capture 

CTRL + 0 Document Auto-Scroll Capture 

CTRL + F11 Interactive Scroll Capture 

CTRL + F12 Session Capture 

 

   
 

You can change hotkeys in the Hotkey Settings dialog box. 

You need to use the mouse to select hotkeys. If you use a number key from the numeric keypad, make sure 

NUM LOCK is turned on. Do not use SHIFT in combination with number keys from the numeric keypad. 

 

If you don't want to use any hotkeys, select Turn off all hotkeys. FullShot will not monitor any keyboard 

activities when the hotkeys are in the sleep mode. 

 

Tip: In general, it’s best to select hotkeys that won’t conflict with keys your current application uses. If a 

FullShot hotkey matches the key for an application, pressing it first carries out the action your application 

defines for the key and then captures an image. Thus, you may find that the application has changed the 

image you wanted to capture. The easiest way to avoid such conflicts is define a Uhotkey combinationU that, 

like the default selections, includes one or more systems keys, for example, CTRL+1 for Screen Capture. 

 

Tip: FullShot’s keyboard display always includes the standard 101 keys. If your keyboard has a different 

number of keys, make sure you select only hotkeys that are actually available on your keyboard. 

 

3.6 Snapshot Button Settings 

Snapshot Buttons are the easiest way to capture images. Seven of the ten capture types have a snapshot 

button. The Mouse Pointer capture does not need a snapshot button; the Title & Menu capture cannot use 

a snapshot button. You can turn on/off any snapshot button in the Snapshot Button Settings dialog box. 
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There are two more Snapshot Button types in the Professional Edition. 

 

Select the Hide in Capture option if you don't want to see the snapshot button image in your captured 

images. 

 

3.7 Image Effects Settings 

3.7.1 Effect Commands 

 

There are four capture effects you can use for your capture tasks during capture or after capture. Changing 

settings can be done via the General menu or on the Effects Settings bar. 

 

     →  

 

3.7.2 Drop Shadow Settings 

 

Opacity: adjusts the amount of opacity for the shadow. 

Angle: adjusts the angle of the shadow in degree. 
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Direction: allows for a preset value for the shadow. It is an alternative to quickly adjust the angle 

parameter. 

Distance: adjusts the simulated distance of the shadow from its background. 

Size: adjusts the simulated size of the shadow. It is in the unit of pixel. 

 

Tip: The Distance setting decides how far a shadow will be away from the image. The larger the value, the 

farther the shadow seems to be. The Size setting decides width of the shadow in pixel. For the Angle 

setting, if you don’t want to figure out where the shadow will be generated by angle, always use Direction 

setting to select one of preset directions: Lower Right, Lower Left, Upper Right or Upper Left. 

 

3.7.3 Stroke Effect Settings 

 

Width: adjusts the width of the stroke in pixel. 

Color: specifies the color of the stroke. 

 

Tip: Use value 1 for the Width if you don’t want to see a strong effect. 

 

3.7.4 Tear Effect Settings 

 

Min: adjusts how far up the tear can be (minimum of image). 

Max: adjusts how far down the tear can be (maximum of image). 

Size: slightly adjusts the randomness of the tear. 

Bottom: applies the tear effect to the bottom edge of the image. 

Top: applies the tear effect to the top edge of the image. 

Right: applies the tear effect to the right edge of the image. 

Left: applies the tear effect to the left edge of the image. 

Uniform: specifies whether or not the tear effect will have uniform teeth. 

 

Tip: Max value should be greater than Min value in order to generate a good tear effect. The Size setting 

decides severity of the tear effect. You can turn on the effect on all four edges of the image. 

 

3.7.5 Glare Effect Settings 

 

Amount: adjusts the amount of glare (brightness on top part of image). 

 

3.7.6 How to Change Settings 

 

FullShot has preset a value for every setting that should look good for most of cases. If you’d like to change 

any setting, double click the name of the setting or single click the setting itself. For example, if you want 

to increase or decrease the opacity of drop shadows, double click Opacity: 

 

   
 

User direction keys on the keyboard (←↑→↓) to change the setting. For the Direction setting of the Drop 

Shadow effect, click the setting to open a drop-down menu and select a direction. 
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Below are five capture samples. 

 

Figure 1: no effects used. 

Figure 2: drop shadow effect used. 

Figure 3: drop shadow and bottom tear effects used. 

Figure 4: drop shadow, stroke and bottom tear effects used. 

Figure 5: drop shadow, stroke, bottom tear and glare effects used. 

 

      
 

Since tear effects are generated randomly, no two images will have the same tear effect. 

 

3.7.7 Apply Effects Command 

 

Effects, if turned on, are automatically applied when you launch a capture. If you have already captured 

images or obtained images from other sources, you can apply effects to a loaded image: 

 

 

3.8 Master Reset 

The Master Reset command allows you to change all settings to their original defaults. If you want 

FullShot to work in the factory default mode, use this command. 
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6BChapter 4. Capturing Images 

4.1 Capturing a Screen 

A screen capture includes everything you see on your display screen or everything in the area you define. 

By default, screen captures include the whole screen.  

 

To capture a screen: 

 

Click  button or 

Press the currently defined hotkeys (e.g. CTRL+1) 

 

You can change the screen capture area within your monitor resolution through the Capture… command 

from General menu. 

   
 

FullShot supports multiple monitors. In the screen capture settings, you can select either the Primary 

Monitor or All Monitors. 

 

FullShot lets you set a countdown timer for screen capture. This feature can help you capture screens that 

might change with any keystroke or mouse click. A capture is delayed for the number of seconds you 

specify so you have time to arrange the screen the way you want it to look. 

 

To use the countdown timer: 

 

1. Select the Countdown option. 

2. Specify the number of seconds. 

3. Click  or press the current hotkeys to start the capture. 

 Timer beeper starts. 

4. Arrange the screen the way you want to capture it. 

 After the number of seconds you specify, FullShot automatically captures the screen. 

5. Turn off the countdown timer after capturing the screen. 

 

4.2 Capturing the Active Window 
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FullShot lets you capture not only complete screens, but also separate ‘windows’ that are part of a screen. 

‘Windows’, in this sense, refers not only to full size application or document windows, but also to smaller 

objects within these windows, such as dialog boxes. 

 

An active window is a window on top of other windows. A dialog box is an active window; an application 

window is an active window, etc. There can be only one active window at anytime. FullShot has its own 

way to recognize the active window. As long as the Snapshot Buttons can be displayed on a window’s 

title bar, that window is the active window. 

 

To capture an active window: 

 

Click  button or 

Press the currently defined hotkeys (e.g. CTRL+2) 

 

As in the screen capture mode, FullShot lets you set a countdown timer for window capture. This feature 

can help you capture a window that might change with any keystroke or mouse click. A capture is delayed 

for the number of seconds you specify so you have time to arrange the window the way you want it to look. 

 

To use the countdown timer: 

 

1. Select the Enable Countdown option. 

2. Specify the number of seconds. 

3. Click  or press the current hotkey to start the capture. 

 Timer beeper starts. 

4. Arrange the window the way you want to capture it. 

 After the number of seconds you specify, FullShot automatically captures the window. 

5. Turn off the countdown timer after capturing the window. 

 

   
 

4.3 Capturing an Object 

An object is a component that’s part of an application. It can be a window, a dialog box, a button, a menu, a 

list control, a tree control, etc. For training or documentation purposes, you may want just to capture a 

small component instead of a large window. The Object Capture is designed to serve this purpose. 
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To capture an object: 

 

1. Click  button or press the currently defined hotkeys (e.g. Ctrl+6). The mouse pointer turns to an 

arrow with a question mark.  

 

2. Select an object bordered by a color frame (red, yellow, blue or green). 

3. Single-click the object to capture it. 

 

   
 

Tip: FullShot uses red to frame a generic window, green to frame a tree control, blue to frame a list control, 

and yellow to frame the system default toolbar and toolbar button. 

 

4.4 Capturing a Region on the Screen 

The Region Capture lets you define any arbitrary rectangular area on the screen to capture. There are three 

shapes you can use in this capture: Rectangle, Rounded Rectangle and Ellipse. 
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To capture a region on the screen: 

 

1. Click  button or 

 Press the currently defined hotkeys (e.g. Ctrl+3) 

 The mouse pointer turns to a crosshair.  

2. Move the pointer to a corner of the area you want to capture and press the left mouse button to anchor 

the starting point. 

3. With the left mouse button held down, drag the mouse pointer to the corner diagonally opposite to the 

starting point until the flexible box completely surrounds the area you want to capture. 

4. Release the mouse button. The flexible box disappears and the area it encircled is captured. 

 

4.5 Capturing a Menu 

Note: the Title & Menu capture feature was developed to capture a pull-down menu with or without the 

menu bar on Windows XP, Windows 2000 and earlier Windows versions and compatible applications. It is 

a legacy tool preserved in the current release. It is not designed for ribbon toolbar style applications. 

 

It defines a rectangle area that includes all the objects you select. FullShot can recognize and separate four 

title/menu objects. If you want to omit any part of the captured area that is not an actual part of a menu 

object, select the Erase Background option. 

 

To capture a dropdown menu or popup menu: 

 

1. Open the menu you want to capture. 

2. Press the currently defined hotkeys for title & menu capture (e.g. Ctrl+4) 

 

There are limitations to the dropdown menu captures. If you cannot capture a particular dropdown menu 

from an application, that's because the dropdown menu might be implemented in a different way. 

Especially when the menu bar is implemented as a special toolbar, menu capture may fail. 

 

   
 

4.6 Capturing an Area Freehand 
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The Freehand Capture lets you capture any arbitrarily shaped area on the screen. 

 

To capture an area freehand: 

 

1. Click  button or 

 Press the currently defined hotkeys (e.g. Ctrl+5) 

 The mouse pointer turns to a pen.  

2. Move the pointer to an edge of the area you want to capture and press the left mouse button. 

3. With the mouse button held down, drag the mouse pointer around the area you want to capture until 

the border surrounds it completely. If you don’t join the edges of the figure you draw, FullShot will 

calculate the capture area for you. 

4. Release the mouse button. The surrounded area is captured. 

 

Below is a freehand capture sample. 

 

   

 

4.7 Capturing the Mouse Pointer 

The Pointer Capture is available in the Professional Edition. 

 

In many programs, the mouse pointer changes depending on the action you are carrying out. For example, 

when you select the Airbrush tool from the toolbox in the Windows Paint program, the mouse pointer 

changes to an airbrush image. FullShot lets you capture the current mouse pointer as a separate image in 

any form. 

 

Mouse pointer capture samples: 

 

 
 

To capture the mouse pointer: 

 

 Press the currently defined hotkeys (e.g. Ctrl+7) 

 

There is no setting for the mouse pointer capture. 
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4.8 Capturing a Long Document 

The Document Capture is available in the Professional Edition. 

 

The content of a window is called a document in FullShot. A document can be a web page, a spreadsheet, a 

word processing document or a layout design. When a document is larger than a window viewing area, the 

displaying window can't display all of its content. Document Capture can help you capture such a 

document by using auto-scroll method. 

 

To capture a long document: 

 

1. Click  button or press the currently defined hotkeys (e.g. Ctrl+0). 

2. The mouse pointer becomes arrow-with-scroll shape.  

 

3. Click on the document you want to capture. 

4. FullShot will automatically scroll the document vertically and try to capture the entire document. 

 

To stop a long document capture, click anywhere on the screen. FullShot will just show you whatever it has 

captured. 

 

Please note that FullShot may not be able to capture a long document from all types of application 

windows. Some applications use non-standard or special scroll method, or even special window rendering 

routines. As a result, FullShot auto-scroll may fail to make a window scroll automatically. In this case, you 

can use the Interactive Scroll Capture method or you can capture individual window content and then use 

the image merge function to manually make a long document shot. 

 

Some windows may contain extra edges that affect the scroll effect. You can use the Line Adjustment 

parameters to eliminate unwanted area. You can also add a frame automatically after a document capture is 

performed. To set options, click the Document tab in the Capture settings. 

 

The performance of a long document capture depends on your system RAM. Since the final bitmap image 

can be very large, make sure you have sufficient memory available for a very long document. 

 

   
 

4.9 Interactive Scroll Capture 
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The Interactive Scroll Capture is available in the Professional Edition. 

 

The Interactive Scroll Capture is an extension of the Document Auto-Scroll Capture. There are a lot of 

applications that FullShot may not scroll their window automatically. As a result, the Document Auto-

Scroll Capture can’t capture the entire hidden window content. If that happens, use the Interactive Scroll 

Capture instead, which works interactively with the user to perform Scroll-and-Capture function. 

 

To capture a vertical long document with Interactive Scroll method: 

 

1. Click  button or press the currently defined hotkeys (e.g. Ctrl+F11). 

2. The mouse pointer becomes arrow-with-ISC shape.  

3. Click on the window you want to scroll and capture. 

4. FullShot will capture the current portion of the window and wait for you to scroll the window. 

5. Click on the down scroll button of the window.  

6. FullShot will automatically analyze your scroll and capture the newly exposed portion of the window. 

7. Repeat steps 5 and 6 until the scroll button reaches the bottom of the scroll bar or you decide to stop. 

8. Press any key on the keyboard or right click the mouse button to stop the Interactive Scroll Capture. 

 

FullShot will stitch all portions it has captured to make a complete image. 

 

To capture a horizontal long document with Interactive Scroll method: 

 

1. Click  button or press the currently defined hotkeys (e.g. Ctrl+F11). 

2. The mouse pointer becomes arrow-with-ISC shape.  

3. Click on the window you want to scroll and capture. 

4. FullShot will capture the current portion of the window and wait for you to scroll the window. 

5. Click on the right scroll button of the window.  

6. FullShot will automatically analyze your scroll and capture the newly exposed portion of the window. 

7. Repeat steps 5 and 6 until the scroll button reaches the right border of the scroll bar or you decide to 

stop. 

8. Press any key on the keyboard or right click the mouse button to stop the Interactive Scroll Capture. 

 

FullShot will stitch all portions it has captured to make a complete image.  

 

As you can see, the horizontal interactive method is very similar to the vertical interactive method. The 

only difference is step 5. The vertical scroll method waits for you to click the down scroll button; the 

horizontal method waits for you to click the right scroll button. 

 

You can let FullShot add a frame automatically after the capture is done. To set this option, click the 

Interactive tab in the Capture settings. 
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4.10 Session Capture 

The Session Capture is available in the Professional Edition. 

 

Session Capture provides a way to capture many screens without user’s interaction. Each capture is 

triggered by a timer preset by the user. Once started, FullShot will perform the specified capture whether 

or not there is any screen change. The captured images will be automatically saved to a specified folder. 

 

To set a capture session, choose the Session Capture settings command from the General menu.  

To start a capture session: press the currently defined hotkeys (the default is Ctrl+F12). The session will be 

ended automatically when the time limit or capture limit is reached. The session can also be ended before 

any limit is reached by pressing the same hotkeys. You can change the session capture hotkey in the 

Hotkey Settings dialog box. 

 

   
 

Full Screen: FullShot will capture a full screen. 

Current Window: FullShot will capture the top most window. 

Use Capture Notification: FullShot will use a sound or screen flash to signal that a capture is done. 

Display Report after a Session: FullShot will display the statistics. 

 



 31 

 
 

Time Interval: This is the timer that triggers each capture. The minimum interval is 1 second. 

Capture Limit: use either the total capture or total time as a limit to stop the session capture. You can also 

stop a session by pressing the same hotkey that launches the session capture. 

 

 
 

Choose a folder to save captured images. 
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7BChapter 5. Working with Image Files 

5.1 Image File Conversion 

FullShot lets you open and save files in many image formats and portable PDF format. You can open a file 

in a supported format even if it was created by another application; thus FullShot can act as an image file 

conversion program. 

 

5.2 Supported Formats 

20 formats are supported in FullShot. 

 

FSD FullShot document format that can store images and annotation objects. 

BMP Windows Bitmap format. 

CUR Windows Cursor format. Read only. 

DIB Windows Device-Independent Bitmap format, a variant name for the BMP format. 

EPS Encapsulated Postscript format. FullShot will display its preview image. Read only. 

GIF Graphics Interchange Format. However, it supports only 256 colors. 

ICO Windows Icon format. Read only. 

JPG Also known as JPE and JPEG. 

PCD Kodak Photo CD format. 

PCT Macintosh Pict format. 

PCX Originally Painbrush format. 

PDF Adobe Portable Document Format. Save only. 

PNG Portable Network Graphics, a standard specified by the World Wide Web Consortium for Internet 

and web development. 

PSD Adobe PhotoShop format. 

RAS Sun Raster format. 

RLE Windows Run-Length Encoded bitmap format, a compressed version of standard Windows BMP 

format. 

TGA Truevision TARGA format. 

TIF Tagged Image File format. 

WMF Windows Metafile Format. FullShot can handle bitmap or raster images in this format, not vector 

images. 

WPG WordPerfect Graphics format. FullShot can handle bitmap or raster images in this format, not 

vector images. 

 

5.3 Opening or Importing an Image File 

To open an image file, navigate and find the file using the FullShot Explorer. And then click on the 

filename to load it into the FullShot window. 

 

You can also choose the Open command from the File menu to open an image file.  

 

5.4 Saving an Image to a File 

To save an image to a new file: 

 

1. Find the target folder in the FullShot Explorer where you want to save your image. 

2. Click on the image in the FullShot window. 
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3. Hold down the mouse button and drag the mouse pointer to the target folder name in the FullShot 

Explorer. 

4. Release the mouse button when you see the target folder is highlighted. 

5. FullShot opens the Save As dialog box. 

6. Select a file format in the Save As dialog box. 

7. Type a filename in the Save As dialog box. 

8. Click Save. 

 

To save an image to an existing file: 

 

1. Find the target file in the FullShot Explorer. 

2. Click on the image in the FullShot window. 

3. Hold down the mouse button and drag the mouse pointer to the target filename in the FullShot 

Explorer. 

4. Release the mouse button when you see the target filename is highlighted. 

5. Click the Yes button to confirm that you want to replace the image file. 
 

To save an image automatically as you capture it: 

 

1. Choose the Capture… command from the General menu. 

 

   

 

2. Select the File destination. 

 If the File option is the only destination, all captured images will directly go to your hard drive. 

 

3. Select a File Option. 

 Increment Filename: When saving files, FullShot automatically assigns the filename and file type set 

with Set File. If the filename ends in a number (e.g. the default filename is 'SHOT0000.BMP'), FullShot 

increases the number sequentially for each new file. By default for example, the next filename will be 

SHOT0001.BMP. If the filename doesn't end in a number, FullShot automatically overwrites any file 

already saved with the currently set name. 

 

 Prompt Filename: When saving files, FullShot opens the Save As dialog box that lets you set a 

filename and file type. 

 

 Filename by Time: When saving files, FullShot automatically creates a filename using the current date 

and time in the form of MM-DD-YY (HHMMSS), where MM is the current month, DD the date, YY 
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the year, HH the hour, MM the minute, SS the second. For example, a PNG file created on 11/30/2015 

at 8:05:16AM is saved under the name 11-30-15 (080516).PNG. 

 

 If you select the Increment Filename, continue with the rest of steps. Otherwise, your setup is 

complete. Click OK. 

 

4. Click Set File to set options. 

 The Set File opens up the standard FullShot Save As dialog box. You need to choose a directory, a file 

format, and a starting filename with one or more digits at the end. FullShot saves the captured image by 

default as a BMP file under the name SHOT0000.BMP in your current working directory. 

 

 
 

5. Click the Save button. 

 

6. Start a capture. All captured images are saved to your hard drive directly. 

5.5 File Size 

If you want to save your image in the smallest format possible, you can use Compare and Save command 

from the File menu or press Ctrl+M. It lists all file sizes for supported formats. It also tells you whether or 

not it is a good idea to save in GIF format that can contain 256 colors only. Saving an image with more 

than 256 colors in GIF format will produce color dithering effect that is not good for documentation or 

online help. 

  



 35 

 

5.6 Color Reduction 

On the older Windows machines, if you want to get smaller image files for your captures, you may set up 

Windows as a 16-color or 256-color environment before you capture images. Newer Windows machines 

don’t have such options. The only mode you can run is true color with 32-bit graphics card. However, you 

can do color reduction with FullShot to produce smaller image files.  

 

Choose the Reduce Color command from the Color menu to reduce the amount of colors in the active 

image. 

 

5.7 Image Compression 

Certain image formats provide compression. PCX, GIF, PNG, WPG, RLE and JPG, for example, are 

compressed image formats. 

 

RLE is suitable only for 16-color and 256-color images. If you save a black-and-white image or color 

image with more than 256 colors, FullShot does not provide compression in the RLE format. 

 

The TIFF (extension TIF) specification allows many different compression methods. FullShot can read 

most of them but does not provide any compression when saving files in TIFF format because of 

compatibility concerns. 

 

The JPEG format (extension JPG) is supported mainly to let users import and export photographic images. 

It has the best compression algorithm for true color photographic images, and it can generate a very small 

image file. However, decompressing an encoded JPEG image does not necessarily restore the original bit-

for-bit. As a result, you should not save screen images in JPEG format because they will not look as sharp 

when they are decompressed. 

 

PNG format is a lossless specification and supports 1-bit, 4-bit, 8-bit and true color image. It has better 

compression ratio than GIF. As a result, PNG format is highly recommended to all FullShot users. 

 

Since FullShot supports the most popular formats for desktop publishing, you should be able to find a 

format you can use with almost any desktop publishing or graphics program. If you are not sure which 

format to use, try PNG format for the greatest degree of compatibility with other applications. Since PNG 

files have built-in compression, they are generally smaller than other formats. 
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8BChapter 6. Printing Images 

6.1 Configure FullShot as a Screen Printing Program 

If you want FullShot to work like a screen-printing program, you need to send captured images directly to 

your printer. Follow the instructions below to make appropriate configuration. 

 

1. Choose the Capture… command from the General menu. 

 

   
 

2. Select the Printer destination. 

Make sure the Printer is selected as the only destination. When a capture of any type is performed, 

FullShot will send the screen image to your printer directly. 

 

3. Select the Use Print Dialog Box option if you want to see the preview before you print. 

We recommend you to select this option because you will have a chance to adjust scaling so that the 

image is printed on the page the way you want it to be. You can also write some notes under or above 

the printed image in the notepad provided in the print dialog box. 

 

4. Click Set Print to set options. 
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This will open up the FullShot Print dialog box. The dotted line indicates how much space a full screen 

image of your current screen will take on a page. Different screen resolution or different printer 

resolution will have different preview size. Changing scaling parameter will affect the image size on 

the page. If you have selected the Use Print Dialog Box option in the step 3, the image size in the 

preview window doesn't matter because you can change the scaling for every image you print. 

 

5. Click OK to complete the setup. 

 

6. Start a capture. 

 From now on, any capture of any type, large or small, will be treated as a screen-printing. 

 

If you want to save the captured images, you need to unselect the Printer as the only destination and 

select other options. 

 

You can turn on/off the Printer as a destination by clicking the Capture to Printer button on the toolbar. 

 

 
 

6.2 Print Images from FullShot Window 

To print the active image in the FullShot window: 

 

1. Press the Print button on the toolbar. 

 The image in the active window is displayed in the preview window. 

2. Select a target printer from the printer list. 

3. Set the Number of copies. 

4. Adjust the Scaling parameter to make the image larger or smaller against the simulated page. 

5. Choose Portrait or Landscape mode. 

6. Click OK. 

 

 
 

Pixel Perfect Print (Round scaling factor for clarity) Option 

 

Certain scaling parameters may distort images that contain text. Pixel Perfect Print is designed to provide 

you with better quality printing. Check this option box if you’d like to see better quality. It dictates your 
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preview scaling image size change. The internal algorithm decides what scaling parameter can produce 

good quality of image printing. 

 

6.3 Notepad 

The notepad in the FullShot Print dialog box allows you to enter a short description about the image. 

 

 
 

FullShot has default formatting for printing image notes. You can make a formatting change by clicking on 

other options. 

6.4 Header and Footer 

You can add a header or a footer or both to all printed pages at three possible locations. You may use 

macros in the header and footer. You can change the font to make the header larger or smaller. 

 

 
 

6.5 Macros 

A macro in FullShot is a single print conversion command that is translated into a FullShot action. 

$printdate, for example, is translated into the current printing date. It gives you a way to define a header or 

footer once and get consistently formatted printout. FullShot supports seven macros in the notepad, header 

and footer.  

 

By default, the header on the right is defined as ‘printed by FullShot at $printtime on $printdate’; the footer 

on the left is defined as ‘$filename, $filetime - $filedate, $res’. 
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Date and time used in the macros can be in different formats. Click Set Date/Time Format to change the 

format to the way you want it to be. 



 40 

9BChapter 7. Working with the Clipboard 

 

 
 

There are four Clipboard commands. 

 

Use the Copy command to copy the image and all annotation objects as an integrated image in the FullShot 

window to the Clipboard. 

 

Use the Copy Object command to copy the image or selected annotation objects in the FullShot window to 

the Clipboard. 

 

Use the Paste command to duplicate the image or annotation objects in the Clipboard to the active image. 

 

Use the Paste as New command to display the image in the Clipboard as a new image. The current active 

image will be replaced.  
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10BChapter 8. Changing Images 

8.1 Resize 

The Scale command from the Tools More menu lets you scale images flexibly, but it can distort the image 

if your changes are not exactly multiples of the original, particularly if the image contains text. 

 

   

 

8.2 Rotate and Flip 

To change the orientation of the active image, choose one of the four orientation commands from the Tools 

More menu.  

 
 

Suppose the original image is . 

 

Flip Horizontal   

Flip Vertical   

Rotate Right   

Rotate Left   

 

8.3 Change Resolution 

This function is available in the Professional Edition. 

 

To change image resolution: 

 

1. Choose the Change Resolution command from the Tools More menu. 

2. Set new resolution. 

3. Click OK. 
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8.4 Merge 

To merge two or more images into one: 

 

1. Import the first image into the FullShot window. 

2. Select Auto Stretch Canvas mode in the Canvas Properties dialog box. This is the default mode for 

newly captured or imported images. (see Chapter 9.2 for more information) 

3. Drag the second image from My Work into the FullShot window. Drag the third image into the 

FullShot window if you’d like to merge more than one image. 

4. Position images.  

5. Use Annotation Object Layers list to arrange the object layer positions. (see Chapter 9.4 for more 

information) 

6. Choose the Save command to save merged images into a file. 

 

There is no limit on how many images you can merge at a time. To delete an image in the merging window, 

bring it to top, and then press the Delete key on the keyboard. 

 

8.5 Black & White, Grayscale and Invert 

To change the active image to black & white, use the Black & White command from the Tools More 

Color submenu. 

 

Please note that this function came from the original FullShot 1.0 implementation back in 1991 when 

Windows had only 16 colors. Its matching color scheme was designed for 16-color (4-bit) environment. It 

is preserved in the program as a legacy function. Users are recommended to use either color or grayscale 

mode to do screen capture for modern documentation work. However, if you work on legacy COBOL and 

similar mainframe applications, you may still find Black & White mode useful in dealing with simple 

color screens. 

 

To change the active image to grayscale, use the Grayscale command. To change each color in a color 

image to its complementary color, use the Invert command. 
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8.6 Reduce Colors 

To reduce the number of colors in the active image, choose the Reduce Colors command from the Color 

menu. 

 

 
 

This function results in a smaller file size with no loss of quality, so it is always wise to reduce colors if you 

can. FullShot first analyzes the image. If it is a true color image, it will try to reduce it to the 256-color 

level; if it is a 256-color image, it will try to reduce it to the 16-color level. 

 

8.7 Crop 

The cropping function lets you trim one or all four edges of an image to eliminate parts you don’t want. 

You can crop each edge separately or all four at once using cropping lines that appear when you select the 

image. 

 

 
 

To crop an image: 

 

1. Set the editing mode to the Crop mode. The mouse pointer becomes a crosshair.  

2. Double click the active image to draw the cropping lines at the edges of the image or draw the 

cropping lines on the image at the position you prefer. 

3. Move the cropping lines by dragging one of the handles on the cropping lines or use keys to move 

lines precisely. 

4. Press the ENTER key or double click the image to complete the crop operation. 

5. A new image is generated and displayed in the FullShot window. 

 

 
 

Keyboard interface is defined as follows: 

 

 Moves the cropping object; with Ctrl key held down, moves the right cropping line; with Shift key 

held down, moves the left cropping line. 
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 Moves the cropping object; with Ctrl key held down, moves bottom cropping line; with Shift key 

held down, moves the top cropping line. 

i Moves all four cropping lines in toward the center of the image. 

o Moves all four cropping lines out toward the edges of the image. 

 

8.8 Blur 

The blur tool allows you to block certain information on the active image from being exposed to public. 

 

 
 

To blur part of  an image: 

 

1. Set the editing mode to Blur mode. The mouse pointer becomes a crosshair.  

2. Draw an area to blur it. 

 

8.9 Highlight 

The highlight tool allows you to highlight certain information on the active image using one of the 24 color 

markers. 

 

To highlight part of  an image: 

 

1. Set the editing mode to Highlight mode and select a highlight color. The mouse pointer becomes a 

crosshair.  

2. Draw an area to highlight it. 

 

 

8.10 Eraser 

The eraser tool allows you to erase certain information on the active image. 
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To erase part of  an image: 

 

1. Set the editing mode to Eraser mode. The mouse pointer becomes a crosshair.  

2. Draw an area on the active image. 

3. Press the Enter key to erase it. 

 

8.11 Check Colors 

The check color function allows you to display a pixel’s RGB value. 

 

 
 

To check a pixel’s color value: 

1. Set the editing mode to Check Color mode. The mouse pointer becomes a black arrow.  

2. Click the pixel on the active image to display its RGB value. 
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11BChapter 9. Adding Annotations 

9.1 Annotation Basics 

Annotation is a way to draw and write your comments into an image. There are three sets of annotation 

tools: 

 

Drawing Tools 

Callout Tools 

Labeling Tools 

 

9.2 Canvas and Editing Modes 

The annotation editor is embedded in the image window. It uses a canvas as its background. When you 

capture an image or import an image, the size of canvas is the same as the size of the image. 

 

There are two modes for the canvas: standard mode and auto-stretch mode. By default, the canvas is in 

the auto-stretch mode in which the canvas changes its size as you add or move images and annotation 

objects. When you drag and drop an image into the window for image merge, the canvas will always adjust 

itself automatically. The canvas will be as large or as small as it is necessary to hold all objects. You don’t 

need to worry about the canvas size. You don’t even need to know what a canvas is. Just think it is a 

stretchable background. 

 

If you need to create an image with a fixed size, you would need the canvas to be in the standard mode. 

 

To set the canvas to the standard mode: 

 

1. Click the Canvas Properties command on Annotation Object Layers list to open the Canvas 

Properties dialog box. 

2. Uncheck the Auto Stretch Canvas option. 

 

You can set a fixed size based on your needs. 

 

   
 

When the canvas is in the standard mode, it displays three handles on the right edge, bottom edge and the 

lower right corner. By default, the handle is in green color. See screen shot below. You can change this 

color and canvas color in Image Window settings from the General menu. See Chapter 3 for more 

information. 
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You can use the New command from the File menu to generate an empty canvas. 

 

9.3 Drawing Tools 

9.3.1 Basics 

 

To use a drawing tool: 

 

1. Click the Draw button. 

2. Select a tool from the panel. The mouse pointer becomes a crosshair.  

 

 
 

3. Start drawing the shape or text on the image or canvas. 

 

9.3.2 Continuous Drawing Mode 

 

If you need to draw an object multiple times, hold down the CTRL key while you draw. FullShot will get 

into the continuous mode and the crosshair cursor will appear again after you finish a drawing. 

 

Not holding down the CTRL key while you draw is considered as single draw action. 

 

9.3.3 Drawing Bracket Objects 

 

There are two types of bracket objects: Curly Brackets and Square Brackets. Both are four directions 

enabled. 
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Take the Curly Brackets as an example. The initial drawing gives you a bracket pointing to right. If you 

drag its handle and move to left, it will follow your move and points to left. When the horizontal dragging, 

left or right, produces a bracket with longer width than height, it becomes a horizontal bracket pointing to 

top or bottom. Again, dragging a horizontal bracket upward or downward produces a vertical bracket when 

its height is longer than its width. 

 

 
 

The Square Brackets work the same way. You can draw a square bracket pointing to any direction. 

 

 
 

9.4 Callout Tools 

9.4.1 Basics 

 

Callout tools allow you to write something inside a callout object. 

 

To use a callout tool: 

 

1. Click the Callout button. 

2. Select a callout style from the panel. The mouse pointer becomes a crosshair.  

 

 
 

3. Start drawing the callout on the image or canvas. 

4. Type callout text inside the object. 
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5. Drag its tail to point to the screen content you want to comment. 

 

You can use gradient colors in all callout objects. To do so, select the first color from the first fill color 

drop-down menu and second color from the second fill color menu. Gradients will be applied 

automatically. 

 

To use single color callouts, select the same color for color 1 and color 2. Below are some callout samples. 

 

 

 
 

9.4.2 Callout Continuous Drawing Mode 

 

Same as the Drawing Tools, if you need to draw a callout object multiple times, hold down the CTRL key 

while you draw. FullShot will get into the continuous mode and the crosshair cursor will appear again after 

you complete a callout. 

 

Not holding down the CTRL key while you draw is considered as single draw action. 

 

9.4.3 Using Two Tails 

 

All callouts allow you to use at least one tail to point to what you want to annotate on the active image; 

however, callout 3, 4, 5 and 6 allow you to use two tails for extra annotation convenience. To enable the 

second tail, click and drag the second green dot inside of the callout object and extend it to any direction. 

 

 
 

9.4.4 Object Popup Menu 

 

If you need to change object positions, delete an object, lock or unlock an object and set display properties, 

right click the object to pop up a menu. Choose a command you need to use accordingly. 
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9.4.5 Other Toolbar Buttons 

 

 Undo: Use this command to undo an action. 

 Redo: Use this command to redo the previously undone action. 

 

 

 Left Align Text command. 

 Center Align Text command. 

 Right Align Text command. 

 Top Align Text command. 

 Center Align Text command. This is for vertical alignment. 

 Bottom Align Text command. 

 

9.5 Annotation Object Layers 

The original image and all annotation objects you added are listed on the Annotation Object Layers list. 

The list is an important tool that helps you select an object and move its layer position up or down by 

dragging. 

 

9.5.1 Object Layers 

 

Images, captured and imported, and annotation drawings are called objects in FullShot. Each and every 

object you see inside the FullShot window is on a separate layer. Even though two annotation objects may 

not overlap each other, they are on different layers. 

 

A layer is assigned when an object is generated. If you don’t change layers, the layer sequence is the same 

as the order in which you generated those objects. 

 

In the sample below, there are one image object, one rectangular callout object and two vector drawing 

objects. The image object is at the bottom and is locked, which means that you can’t move the image 

object. To change object layer orders, drag an object and move the mouse pointer up and down the list. 

 



 51 

 
 

9.5.2 Object Locking 

 

When an object is locked, it means that you can’t select it and can’t move it by dragging. Normally, the 

image object is locked when you perform a capture or open an image file. 

 

To lock or unlock an object: 

 

1. Right click the object item on the Annotation Object Layers or right click the object on the image. 

 

 
 

2. Choose the Toggle Lock command. 

The yellow lock image is displayed when an object is locked; the lock image is removed when the 

object is unlocked. 

 

9.5.3 Object Commands 

 

 Canvas Properties: Use this command to set the current canvas settings. 

 Object Properties: Use this command to change object opacity and drop-shadow settings. 

 Toggle Lock: Use this command to lock or unlock an object. 

 Delete: Use this command to delete one or more selected objects. 

 Clear All Objects: Use this command to delete all annotation objects. This action is NOT undoable. 

 

9.5.4 Turn On/Off Object Drop Shadows 

 

1. Select the object on the Annotation Object Layers list. 

2. Choose the Object Properties command to open the property dialog box. 

3. Click the Settings column of the Enable row under the Drop Shadow section. 

4. Choose False to turn shadow off; choose True to turn it on. 
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9.6 Using Labels 

To draw one or multiple labels: 

 

1. Press the Label button. 

2. Select a label style. 

3. Click anywhere on the image or canvas to draw a label. Repeat this action to draw more labels. 

4. To stop drawing, press Esc key on the keyboard. All labels are numbered sequentially. 

 

 
 

To change the starting number, label style and label size: 

 

1. Choose the Settings command from the Label Panel to open the Label Settings dialog box. 

2. Change settings and click OK. 

 
 

To change the label frame color: 

1. Choose the Group Selection from the Tools More menu. The cursor becomes a crosshair.  

2. Select one or more labels by dragging the crosshair cursor. 

3. Release the mouse button after the selection. 

4. Click Line Color command on the toolbar to open its color menu. 

5. Select a color. 

6. The color will be applied to the selected labels. 
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To change the label font color: 

1. Choose the Group Selection from the Tools More menu. The cursor becomes a crosshair.  

2. Select one or more labels by dragging the crosshair cursor. 

3. Release the mouse button after the selection. 

4. Click Font Color command on the toolbar to open its color menu. 

5. Select a color. 

6. The color will be applied to the selected labels. 

 

To align all labels with the top frame of an anchor label: 

 

1. Select one label as the anchor by clicking it. 

2. Choose the Top Anchor Align command from Label submenu of the Tools More menu. 

3. All labels will be aligned with the top frame of the anchor label. 

 

To align all labels with the left frame of an anchor label: 

 

1. Select one label as the anchor by clicking it. 

2. Choose the Left Anchor Align command from Label submenu of the Tools More menu. 

3. All labels will be aligned with the left frame of the anchor label. 

 

To align a group of labels with a top frame: 

1. Click the Group Selection from the Tools More menu. The cursor becomes a crosshair.  

2. Select labels you want to align by dragging the crosshair cursor. 

3. Release the mouse button after the selection. 

4. Choose the Top Group Align command from Label submenu of the Tools More menu. 

5. All selected labels will be aligned with the top frame of the label that has the lowest sequential 

number. 

 

To align a group of labels with a left frame: 

1. Choose the Group Selection from the Tools More menu. The cursor becomes a crosshair.  

2. Select labels you want to align by dragging the crosshair cursor. 

3. Release the mouse button after the selection. 

4. Choose the Left Group Align command from Label submenu of the Tools More menu. 

5. All selected labels will be aligned with the left frame of the label that has the lowest sequential 

number. 

9.7 Saving Annotations in FSD 

You can save your creative work to a FSD (FullShot Document) file by choosing the Save command on the 

ribbon toolbar. Anyone who has FullShot can open this type of files and add new or modify existing 

annotated contents. 
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12BChapter 10. Image Tools 

10.1 Batch Conversion 

Batch Conversion is a tool that can help you convert image files from one format to another. It is available 

in the Professional Edition 

 

To launch Batch Conversion, choose the Batch Conversion command from the File menu. 

 

   

 

To convert image files to another format: 

 

1. Select an input directory. 

2. Select an input format or All Supported Formats. 

3. Select image files that you want to convert or click Select All to select all image files in the selected 

directory. 

4. Select an output directory. 

5. Select an output format. 

6. Click the Convert button. 

7. Batch Conversion will show you the conversion result in its list window. 

 

The above example shows that 18 files in C: directory are selected, converted to PNG format and 

successfully saved in C: directory. 

 

10.2 ImageExplorer 

ImageExplorer is available as one of the Legacy Tools in FullShot 10 Professional Edition. 

 

There are hundreds, even thousands, of images on your hard drives that you never realize taking so much 

disk space. When you surf on the net, your browser quietly gathers images and saves them to your hard 

drive for faster page jumping. Another amazing fact is that your Windows Explorer sometimes can't list all 

of those images. 
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ImageExplorer can list, sort and display all of the images on your hard drives no matter where they are 

and how they got there. 

 

To launch ImageExplorer, choose the Legacy Tools command from the File menu to launch FullShot 

Tools – a separate application. And then click the ImageExplorer button on the toolbar . 

 

  
 

To sort images by Name, Size, Type, Modified Date or Location, click the correspondent column header. 

 

There are three sections in the status bar that is at the bottom of the ImageExplorer: 

 

1. The total number of image files listed in the ImageExplorer. 

2. The total hard drive space taken by the entire listed image files. 

3. The number of open windows. 

 

  Click Summary Report button to display image file statistics. 

 

Select Image Formats and Drives 

 

When you launch ImageExplorer, you will see a format selection dialog box. 
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This dialog box lets you select image formats and drives on which you want ImageExplorer to scan and 

list. Different PCs may have a different number of drives. By default, only hard drives and all of the 

supported image formats will be scanned. 

 

You can re-scan your PC at anytime by clicking the ImageExplorer icon on the toolbar.  
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